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SECTION 1. Introduction 
 
1.0 Before you begin: 
 
This guide will quickly introduce you to Platts Sarus and enable you to get the most out of 
your new software. More detailed instructions are available by pressing the F1 function key 
(or the Help menu) in Platts Sarus. 
 
 
1.1 Starting Platts Sarus: 
 
To run Platts Sarus double click on the Platts Sarus icon in the Platts Sarus Group (See 
Fig.1). As the software loads, you will see a window with the Platts Sarus Workstation 
legend. After waiting a few moments for the software to load, a beep will sound and the 
Wait button will change to OK . Click on the OK button and you are ready to begin. 

 
 

    
 
 
 
 
 

Fig.1. The P latts Sarus icon. 

 
At the top of the Platts Sarus Workstation window are four drop-down menus. At the bottom 
of the window is a toolbar known as the ‘Main Control Bar’ (See Fig.2). 
 
 

 

 
 

Fig.2. The Main Contro l Bar 
 

 
Some of the buttons on the Main Control Bar are initially ‘greyed out’. This means that these 
buttons are not valid until later in the program. For example, the three buttons on the left 
hand side control scrolling a chart, so a chart with some data series must be open before 
these buttons can be used. 
 
 
1.2 The Main Control Buttons: 
 
 
The main buttons on the bar are: - 
 
  

   The Chart button allows you access to the main charting functions - create, 
save, load, delete and print. 

 

 The Analysis button allows you to add data, formulae, spreads, averages 
and statistics to the chart. 
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 The Sheet button allows you to show, hide or print the current worksheet. 
 
 
 

    The Utilities button allows you to manually download data, edit the default 
system settings, view a series of data with no conversions and view the 
communications log. 

 
 

 The File button allows you to access export data, set-up the printer, tabular 
history edit, configure a data series and exit Sarus. 

 
 

 This button temporarily reduces the number of days of data displayed in the 
date axis of the current chart in 50-day increments. 

 

 This button temporarily increases the number of days of data displayed in 
date axis of the current chart in 50-day increments. 

  

 As above but you can select the number of days in the chart axis and set 
maximum and minimum ranges for the price axis. 

 
 
 
 
1.3 The Top menu bar: 
 

At the top of the Platts Sarus window, there are four drop down menus (See Fig.3). 
 

 

 
 

Fig.3. Platts Sarus Main Menu. 
 
 

The Four Menus are: 
 
 

Edit:  The Edit menu allows you to copy a chart to the clipboard. 
 

Desk: The desk menu allows you to load & save desktops (a collection of charts & 
worksheets). 

 
Window:  The Window menu allows you to tile and cascade chart & worksheet 
windows. 
 
Help: The Help menu displays the full on-line Platts Sarus Manual and system 

information. 
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SECTION 2. The Platts Sarus Profile Manager 
 

2.0 Introduction: 
 
The Sarus Profile Manager allows users to easily select the series they wish to use on a day-to-
day basis from the thousands of commodities available on the Platts Dispatch FTP feed. The 
program replaces the Activate/Deactivate functions that were in previous releases of the Platts 
Sarus Workstation. 
 
The main program window is split into three panes and has two dropdown menus, File and 
Help. The pane on the left, ‘Folders’, contains all available Platts Dispatch categories, organised 
in folders.  
 
When the user clicks on the category (Crudes/International in the example below) the series in 
that category are displayed in the top-right pane.  A flag identifies series that are already in 
your profile in the bottom-right pane. You can double click on any of these series to append 
them to your profile, or if enabled (see the File/Settings menu), you can simply drag and drop 
them. If series details needed to be edited then you will be asked to supply these details. See 
‘Series Properties’ later in this section for more information. 
 
Both the Category and Profile pane have popup menus that are activated when you right click 
on them.  These manus allow the series to be filtered, sorted and edited. Please read on for 
more information on these features.  
 
Once you have added the series you can save your profile using the ‘File’ menu. You can also 
backup and reload a saved version of your profile 

 

 
Fig.4 . The Profile Manager 
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2.1 Launching the Program: 
 
The Profile Manager can be run from your Platts Sarus Workstation by clicking on the “Utilities / 
Organize your Profile” buttons, or from the Windows Explorer by launching the “Activate.exe” 
application (located in your Sarus Database directory). 
 
When run you will see a dropdown menu and the main window split into three panes.  
 
 
2.2 Platts Folder Pane: 
 
The pane on the left contains the Platts Dispatch categories ordered by folder where necessary. 
The Folders can be opened to show the Categories by clicking on the “+” symbol and closed 
using then “-“ symbol. 
  
Each Folder has two or more Platts categories. In the example (See Fig.4), the Folder is “Crudes” 
and the Category is “International [RI]”. When you double click on a Category, its contents are 
displayed in the top pane so that they can be added to your profile.  
 
 
2.3 Selected Category Pane: 
 
The top pane contains the series that are available in the selected category. The first column 
can contain a Flag symbol to indicate that that series is already active (See Fig.4). The other 
columns contain the series details some of which can be edited. You can sort the series by 
clicking on a column header and a pop-up menu is available when the right mouse button is 
clicked. 
 
 
 

 
 

Fig.5. The Selected Category Pop-up menu. 

 
 

There are six options available on this menu 
 

  View Columns.  Select which columns you wish to see displayed.  
 
 
  Copy. Will copy any selected Series to the application Clipboard for pasting in 

the bottom pane, the User profile. 
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Fig.6 . The View Columns Window. 

 
 

  Filter. The Filter option allows you to view only series containing certain 
information. You can apply up to 3 filters on the code, category or 
description fields.  

 
 

 
 

Fig.7. The Filter Window. 

 
You can select which fields to filter on by clicking on their dropdown arrow (See Fig.8). 

 
 

 
 

Fig.8. The Filter Window Field  Selector. 
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  Clear Filter. Removes the filter and displays all series available in the 

Category. 
 
 

  Series Properties.  This option allows you to change the descriptions or 
conversion factors for one or more selected series. 

 
 
 

 
 

Fig.9 . The Series Properties Window. 

 
You can edit the settings than click on the OK button to save the changes or Cancel to return 
to the main window.  
 
Note: If you are editing more than one series the fields will be blank unless all of the selected 
series have the same data in that field. Any changes made will be applied to all the series 
selected. 
 
You may be asked to supply some details of a selected series like: - 
 
Description: -  Type in a long description for the series. 
Unit: -  Select a unit of measurement from the drop down list. 
Key: -  Type in a short name for the series. 
Conversions: - Type in an operator followed by a number. E.g. /. 42 or *7.62. 
 
 
If you require assistance please refer to the on-line help, your Platts Guide to Specifications or 
contact your Platts Consultant. 
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2.4 Active Profile Pane: 
 
The bottom pane contains the series that are currently active in your profile. You can add to 
or delete from this list by double clicking on a series in the ‘Selected Category’ pane. If 
enabled, you can also drag and drop series from the ‘Selected Category’ pane too. Please 
refer to the settings section for information on enabling or disabling these features. 
 
 
As with the Selected Category pane the displayed series can be sorted by clicking on a 
column header and a pop-up menu is available when the right mouse button is clicked. 

 
 
 

 
 

Fig.10. The Active Profile Pane pop-up Menu. 

 
 
 

The ‘View Columns’, ‘Filter’ and ‘Series Properties’ functions are identical to the menu in the 
Selected Category Pane.  Please refer to this section for more details. 

 
 

The three remaining menus are: 
 

  Cut.  Removes the selected series and copies them to the applications clipboard. 
This has the same effect as de-activating series in previous versions of Platts 
Sarus. 

 
  Copy. Copies the selected series to the applications clipboard. 
 
  Paste. Pastes series from the applications clipboard into the Series profile at the 

current mouse position. 
 
 

When changes have been made you can use the File menu to save them.  
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2.5 The File Menu: 
 

   
 
 
 
 
 
 
 
 

 
Fig.11 . The File Menu. 

 
 
The File Menu has four options. 
 

 1. Settings.   
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.12. The Settings Window 
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The Future Contracts Group box allows you to control how futures contracts are 
displayed in the ‘Selected Category’ pane.  

 
The ‘General’ Group box has 4 active options 

 
  Save window settings controls whether to save the applications window 

size and location when exiting the program. 
 
  Allow multiple series in Profile allows more than one entry in the profile 

for any one series. 
 
  Allow column sorting in Profile allows you to sort the Profile series by 

any column. Remember that when you save the Profile, this order will be 
saved too.  

 
  Allow Drag and Drop in Profile allows you to drag series from the 

‘Selected Category’ pane and drop them in the ‘Active Profile’ Pane. You can 
also re-order series in the ‘Active Profile’ Pane by dragging them to a new 
position. 

 
 

Click on the ‘OK’ button to save the new settings or the ‘Cancel’ button to abandon any 
changes. 
 
 
2. Backup Profile.   
 
The Backup profile has two menus 
   

i. Backup the Current Profile allows you to save the current user profile to a file. 
ii. Reload a Backup allows you to reload a backed up profile file. 

 
 
3. Save Profile and Exit exits the program saving any changes to your user profile. 
 
4. Exit (No Save) exits the program without saving any changes to your user profile. 
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 2.6 The Help Menu: 
 

 
 

 
 
 
 
 
 
 

 
Fig.13 . The ‘Help ’ menu. 

 
The Help Menu has two options 

 
  Find Category for Code enables you to easily locate the correct Platts category for 

a particular code or to locate a category in a folder. 
 

 
 
 
 
 
 
 
 
 
 

 
 
Fig.14. The ‘Locate Category fo r a Code’  Window. 

  
Choose whether you wish to find a Platts nine (9) character code or a Platts Dispatch 
Category by clicking on the appropriate radio button. 
 
 
Enter the code or category and click on the ‘OK’ button and, if the code or category is 
found, the application will notify you and when you click ‘OK’ again, the ‘Platts Folder’ pane 
will highlight this Category. 

 
  About simply displays the applications ‘About’ box. This window displays a 

Version number and links to enable you to contact both Platts and Sarus. 
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SECTION 3. Charting 
 
3.0 Creating a new chart: 

 

1. Activate the chart menu by clicking on the  button. 
 
2. Click on the New button to display the New Chart Set-up window (See Fig.14). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig.15.  The New Chart Set-up Window 
 

 
3. Enter a name for the new chart; e.g. ‘Brent Chart’ in the Chart Name list box. (See 

Fig.15). This name will appear on the Chart title bar. 
 
 

Note:  The Chart unit of measurement is by default set to US$ per barrel. 
This can be changed to US$ per metric ton, US cents per gallon, US cents per 
pound weight an None i.e. no unit of measurement is se lected.  
 
If you subscribe to the Foreign Exchange (FX) category from Platts Dispatch, 
you can create charts using a currency against any capacity or weight. For 
example, you can have French Francs per kilo, or Deutschmarks per long ton.  

 
 
4. Select the Chart Unit of Measurement (UOM) you require and click OK. 
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3.1 Loading Data into the Chart: 

 
You can have up to 14 plots (lines) in a Platts Sarus chart.  
 
 
1. When the new chart, (in our example called Brent Chart [Current]), appears, click 

on the  button to display the ‘Analysis menu’ (See Fig.7).   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.16.  Analysis Menu 
 

 
2. Click on the Load Data Series button and you will be presented with the Select a 

Data Series to load window (See Fig.17). 
 

  This window contains a list of activated Platts data series (See Section 2.0 Activating a 
Data Series) available to you. As well as a description, all Platts categories have a 
unique code and a category name. E.g. PC012$1$H and [CRUDES.RI] (See Fig. 8).  

 
  In our example chart we will use the Brent Oil Data Series which is: - 

 
 

PLA TTS / BRENT  / SOURCE / FIRST MONTH OUT / UNSPECIFIED / HIGH [PC012$1$H] / [CRUDES.RI] 
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Fig.17 . The Select Data Series Window 

  
3. As there are normally many series active in this window at any one time (See Fig.17), 

Platts Sarus can help the user easily locate the series required using the: - 
 

  Word Search button to find a series containing a key word e.g. ‘Brent’. 
 
  Filter button to display only series names that match a phrase (See Fig.9).  

 
 

Note: You can select to chart the Mean  (an average of the high and low prices) of the 
series, by clicking on the M ean  checkbox. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.18.  The Filter Window 
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 4. In our example we will use the Filter button to find the series we require. 
Type in the words ‘BRENT’ and ‘FIRST’ in the textboxes and click the OK 

button.  Only series containing these two words will be displayed. 
 
5. Now double click on the selected series, and you will be presented with the 

‘Configure New Chart Line’ window (See Fig.19).  
 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
Fig.19.  The Configure New Chart Line Window  

 
6. The Configure New Chart Line window allows you to change the default settings for 

the line to be charted. The settings that may be changed are: marker type and colour, 
line type and colour and start and end dates of the series. 

 
 

7. You must now select the dates you want to use in the chart. 
 

Note :  Start and End Dates: The default dates offered for a series normally are the first and last 
available dates for the series. For a subset of this series, change these dates. The earliest date 
that can be used is January 1 1976. 
 

 
8. Now click the OK button and you will be presented with the Update Chart window (See Fig.20). 

From here you can select which axis you want the chart line to appear on. A Chart has 4 axes, 
Top, Bottom, Left and Right.   

 
9. When you have selected the required axis click on the Yes button. 
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Fig.20 . The Update Chart 

 
10. You will now be presented with your completed chart, with the title ‘Brent Chart 

[Current] visible at the top. Along the right side is a scale showing the price in US$ per 
barrel and along the bottom is the chosen date scale. The [Current] legend defines 
which chart (if more than one is open) commands apply to. 

 
Note: You can use the zoom button on the main toolbar to view the chart in more detail. 
(See Section 3.8. Zooming the Chart). 
 

 
3.2 The Worksheet: 
 

Each chart has it’s own worksheet which contains its data. As data series are added to, or 
deleted from a chart, the worksheet is updated to reflect the changes. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.21. Sample Worksheet 
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1. Now that you have a chart open with data loaded, all of the Menu Bar buttons 

are now active. Click on the  button and ‘ The Sheet Menu’ will appear. 
Click on the Show button and the worksheet will be displayed alongside the Chart (See 
Fig.21). 

 
2. The first column of the worksheet always contains the date series for the chart followed 

by the price series for each chart line, in the order in which they were loaded. Data 
series are named after their unique Platts code or study type e.g. Spread (See Fig. 21). 

 
No te: The worksheet displays all data as daily data, Monday to Friday only.  For dates 
on which no prices were reported, a series of asterisks are displayed for that date. 

 
3. Each chart has a 'hot' link to its own worksheet. For example, if the mouse is clicked 

inside the axis of the chart the worksheet will scroll to display the date/price nearest 
the position clicked on the date axis of that chart. 

 
4. You may use the scroll bars to view the data.  Also, if you click on the sheet first, you 

can use the cursor keys - e.g. PgUp, PgDn - to move around the sheet.  
 

 
3.4 Saving the current chart: 
 
To save the current chart, click on the Chart button and select the Save option. Saving a chart 
stores the chart to a disk file that may be reloaded later. Type in the name of the chart you wish 
to save. The name you choose can be up to a maximum of eight characters long. E.g.’Brent‘. 
 

 
3.5 Closing the current chart: 

You can now close the chart by selecting the  button.  
A window will be presented giving you three options (See Fig.22). 
 
 

You can select from one of the three options presented. 
 

  Close   Closes the chart without saving. 
  Save    Saves and closes the chart. 
  Cancel   Cancels the close request. 

 
Click on the Close button. 

 
 
 
 
 
 
 
 
 
 
 

 
Fig.22 .  Closing a chart 

 
Note: You can also close a chart using its system menu. 
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3.6 Loading a chart: 
 
Loading a chart allows you to display a previously saved chart. 
 
 

1. Activate the Chart menu by clicking on the  button. 
 
2. Click on the Load button to display the Load Saved Chart window (See Fig.23) 

showing a list of saved charts. Select a chart by clicking on the name and then 
clicking on the OK button. The saved chart will then be displayed. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.23 .  Load ing a chart 

 

 
3.7 Printing the current chart: 
 

1. Activate the chart menu by clicking on the  button. 
 
2. Click on the Print button and the Chart Printer window (See Fig.24) will appear asking you 

to confirm that you wish to print the current chart. 
 

 
 
 
 
 
 
 
 
 
 
 

  Fig.24. Chart Printer Window  
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 You can select from one of the three options presented. 
 

 
  OK   Prints the chart. 
  Cancel  Cancels the Print request. 
  Set-up  Configures your printer for printing. 

 
 

3.8 Zooming The Chart: 
 
It is possible to zoom both the date (X) axis and the price (Y) axis using the Zoom button 
located on the main menu bar. Clicking on this button activates the Zoom/Scale Chart window  
(See Fig.25). 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.25 . The Zoom / Scale Chart window 

 
The following options are available from this window: - 
 

1. Number of Days for Zoom (Date Axis Zoom): 
 
Type the number of days that you wish to appear on the Date axis of the chart. A scroll 
bar will appear on the bottom allowing you to scroll through the chart (See Fig.25).  Type 
the number zero to remove the Date Axis zoom. You can also type in the exact dates in 
the YYMMDD format in the Start Date and End Date textboxes. 
 
2. Temporary Chart Range (Price Axis Zoom): 
 
You can also zoom in on the price axis of the Top or bottom chart pane. Simply type the 
maximum and minimum value in the Temporary Chart Range edit boxes and select the 
Top or bottom pane to apply this zoom to (See Fig.25). 
 
3. Reset Button: 
 
Clicking on this Button removes any zoom on the current chart. 
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3.9 Summary: 
 

You now know the fundamentals of using Platts Sarus. You can now: - 
 

  Activate Data Series. 
  Create and name a new Chart. 
  Find and load data series. 
  Display the Worksheet. 
  Save and Close a Chart. 
  Load a Chart. 
  Print the Chart. 

 
 
  
 

Note: Like any other window, a chart or a Worksheet can be moved, resized and iconised 
using the mouse. Refer to your Microsoft Windows documentation for further information on 
how to move and resize windows. 
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SECTION 4. Advanced Options 
 
4.0 Introduction: 
 
In this next example, but this time we will show the mean of two data series and the 
spread between them. This section will also show the user how to use different axis to 
chart series. 
 
The two Data series we will use will be: 
 
1. The Mean of Brent 1st Month out whose code is: -   PC021$1$H 
 
2. The Mean of West Texas Intermediate (WTI) whose code is: -   PC045$1$H. 
 
 

4.1 Loading the two Data Series: 
 
1. Create a new chart (See section 2.1 Creating a new chart). 
 
2. Load the two series above into the chart (See Section 2.2. Loading Data into the 

Chart) using the Top Right Axis for both.  
 
3. Remember to click on the mean checkbox so that Platts Sarus automatically loads the 

mean of that series (See Fig.17). You can select either the high or the low price of a 
series but both must be activated for Sarus to calculate the mean. 

 
 

4.2 Charting the Spread: 
 
We now have the two series charted using the top right axis and we will now calculate 
their spread and chart it in the bottom left axis (See Fig.28). 
 
1. Click on Analysis button followed by the Spread button. You will be presented with 

the ‘Create a Two Series Spread’, window (See Fig.26). 
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Fig.26. The C reate a two Series Spread Window 
 
 

 
 
2. Use the Load Series # I and Load Series # 2 buttons (See Fig.26) to load the two 

series (See Section 3.2. Loading Data into the Chart), and then click on the OK 
button. 

 
3. You will again be presented with the ‘Configure New Chart Line’ window (See 

Fig.19).  
 
4. Change the default line colour to blue by clicking on the Line Colour button. From 

the list of colours in the right hand list box, double click on the colour blue and the 
box in the left-hand window will change to the chosen colour. 

 
5. Select the Bar Width Radio Button in the ‘Line Type’ section to select a bar line, 

and then click on OK. (See Fig.19).  
 
6. Click on the Use Chart Dates list box to select automatically the same start and 

finish dates for both series and then click on the OK button. 
 
7. You will be presented with the Update Chart window (See Fig.27). Select the 

Bottom pane and Left Axis. This will position the Spread line in the bottom pane of 
the chart. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.27. The Update Chart 

 
 

8. Next click the Yes button to continue and chart the line. 
 
9. You will now be presented with the chart showing all three chart lines (See Fig.28) and 

the Worksheet will have been updated to show the Spread (See Fig.29). 
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Fig.28 . The Fin ished Chart 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig.29. The Worksheet showing the Spread 
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SECTION 5. Averages and Statistics 
 
 
5.0  Averages: 
 
Sarus has the ability to create five types of average 
 
  Moving Average 
  5-day Average 
  7-day Average 
  Weighted Average 
  Stepped Average 
 
 
In this guide we will only create a moving and weighted average. Please refer to the full Platts 
Sarus Workstation manual or on-line Help, for instructions on creating other types of average. 
 
 

5.1 To Create a Moving Average: 
 
 

1. Click on the  button. 
 
2. Click on the Averages button to display the Averages Menu window below (See Fig .30). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.30.  A verages Menu Window 
 
 

3. Using the Averages Menu window, select the data series you wish to calculate the Average 
on by clicking on its name in the Select Series list box (See Fig.30). 
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Fig.31 . The Moving Averages Window 
 

 
4. Click on the Moving Average radio button from the 'Select Type' list box and then click 

on the OK button to display the Moving Averages window with its options (See Fig.31). 
 

  Periods to Average. In this list box you can enter the number of days over 
which to calculate the moving average.  

 
  Centre Offset. The moving average study can now have a centre offset. For 

example, a 14 day moving average with a zero centre offset would be calculated 
on the previous 13 days before the date being calculated. Applying a centre 
offset of 7 would cause the previous 7 days before the date being calculated 
and the next six days ahead to be used for the average calculation.  

 
  Envelope. The Moving average study can now be displayed with a + or - 

integer value. This study displays two lines on the chart representing the true 
average + and - the number selected. The spreadsheet however shows the true 
moving average without the envelope value. 

 
 
5. Enter the number of days and, if desired, the offset. Click the OK button and a window 

will appear asking if you wish to chart the moving average of the selected data series.  
 
6. Chart in the usual manner and when asked whether you wish to update your current 

chart with the moving average, click on the “Yes” button to chart the average. 
 
 
 
 
5.2 To create a Weighted or Stepped Average: 
 
 
Weighted and Stepped Weighted moving averages are statistical methods for placing a greater 
weighting on the most recent data when calculating moving averages. 
 
 

1. Click on the  button on the Main Control Bar. 
 
2. Click on the Averages button to display the Averages Menu window (See Fig.30). 

 
  Weighted:   Reduces the weighting value for each period under 

consideration. 
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  Stepped Weighted: Allows you to adjust the period of weighting reduction 

according to need. 
 
 

NOTE: The weighting and step must be positive whole numbers. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig.32.  P latts Average Menu . 
 

 
3. Click on a series name in the Select Series list box. 
 
4. Click on the Weighted Average or Stepped Weighted average radio buttons and then click 

on the OK button to continue. (See Fig.32). 
 
5. As with the Moving Average, fill in the dialog and click OK to proceed and chart in the usual 
manner. 
 
 
5.3 Studies: 
 
Sarus has the ability to create seven studies: 
 

  Statistical Regression 
  Relative Strength Index 
  One Standard Deviation 
  Two Standard Deviations 
  Moving Maximum 
  Moving Minimum 
  Moving Total 

 
 
In this guide we will only create a Statistical Regression study. Please refer to the full Platts 
Sarus on-line Help, for instructions on creating other types of studies. 
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5.4 Adding a Relative Strength Index: 
 
The relative strength index is a measure of how much 'strength' or likelihood of continuity is left 
in a trend. 
 

1. Click on the  button on the Main Control Bar. 
 
2. Click on the Statistics button from the Analysis Menu. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.33.  Statistical Functions Menu. 

 
 

3. From the Statistical Functions Menu (See Fig.33) select a data series by clicking on its 
name in the ‘Select Chart Series’ list box. 

 
 
 
 
 
 
 
 
 
 

 
Fig.34. Statistical Functions Menu. 

 
4. Click on the RSI button then click on the OK button to display the Relative Strength 

Index window (See Fig.34). Enter the number of periods over which you wish to 
calculate the RSI, and then click on the OK button. 

 
5. A window will appear asking if you wish to graph the RSI in your current chart. 
 Click on Yes to chart the RSI. 
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SECTION 6. FORMULAE  
 
6.0 INTRODUCTION: 
 

Sarus allows complex formulae to be created, stored and retrieved. 
 
A formula layout is as follows: 

 
  Each formula must begin with a letter signifying the period for that formula: - D, W, M, 

Q or Y (Day, Week, Month, Quarter or Year) followed by a space. 
 
  If the formula is to be based on a 7-day week (a calendar series) then it may begin with 

C. e.g. CW, CM, CQ or CY. For ‘Straight’ series, an S is used instead of a C. e.g. SW, SM, 
SQ or SY.  

 
  Straight Averages are calculating having first excluded dates for which there are no 

prices and Platts use straight Averages in their computations. 
 
  You may then use a combination of brackets, codes, operators and constants to create 

the formula. This can be done using the calculator buttons and/or the keyboard.  
 
  To edit the formula using the keyboard, click the mouse in the white formula window. 

You may then edit the text in the formula window.  
 
 
 

PRIORITY RULES: 
 
Note that macros have priority over operators.  
 
The priority rules used for operators are known as ‘BODMAS’.  
 
  Brackets   
  Order  - equal operators have priority from left to right. 
  Divide 
  Multiply 
  Add 
  Subtract. 
 

  Divide and Multiply operations are calculated before Add and Subtract. 
 
  Divide and Multiply are equal in importance, as are Add and Subtract. 
 
  Calculations enclosed within brackets are calculated first from left to right using rules 1 

& 2 above. 
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6.1 VALID MACROS: 
 
 

&  The ‘Concatenate’ macro. The macro allows two series to be joined together as one. 
E.g. PC034$1$H & PC045$$1H.   The second series is appended to the first 
series. Any overlapping prices will be from Series 2 only. Both Series 1 and Series 2 
must be date/price series.  

 
@F  The ‘Fill’ macro, when appended to a Platts code causes the series to be filled 

forward with the previous valid price. This means all zero values and missing prices 
are replaced with the previous valid price and filled to the last date for that series.  
E.g. PC045$1$H@FH@F 

 
@D  The ‘Fill to latest date’ macro. As above, when this macro is appended to a Platts 

code causes the series to be filled forward, to the latest working date, with the 
previous last valid price. E.g. PC045$1$H@DH@D 

 
-D The ‘Lag’ macro. -D## moves the starting date for a price series back ## number 

of days, e.g. a series starting on 950105 with a -D3 applied, would display the full 
series as beginning on 950102.  

  
+D The ‘Lead’ macro. As above but moves the start date forward. 
 
^  The ‘Begin series at date’ macro. If inserted after a series code, moves the entire 

data series back to that date, i.e. in a series starting on 930601, with a  ^760101 
would display the full series as beginning in January 1st. 1976. 

 
    

E.g. PC045$1$H^760101 
 
 
 
6.2 VALID OPERATORS: 
 
         

*       Multiply the result is Series 1 (S1) multiplied by Series 2 (S2). 
/       Divide  the result equals the contents of S1 divided by S2. 
-       Subtract the result equals the contents of S1 minus S2. 
+      Add  the result equals the contents of S1 added to S2. 
%     Percent the result is N percent S 1. When using the percent operator, you 

cannot have numbers on both sides of the operator, i.e. 12 % 
PC012$1$H is correct but 12 % 5 is incorrect. 

 
 

EXAMPLES: 
 

D ( PC045H1$H  + 0.750 )  + (  PC045H1$L +   0.845 )  /  2 
 
SW ( PC045H1$H  +   PC045H1$L )  /  2 ‘ Straight Weekly Mean  
 

  D ( PC012$1$H  &   PC045$1$L )   ‘ Concatenate  
 
  D ( PC045$1$H -D3 )    ‘ 3 Day LAG 

Evaluation notes were added to the output document. To get rid of these notes, please order your copy of ePrint IV now.



Platts Sarus Workstation Manual 
 

 
 Page 33 
 

 

 
 

6.3 CREATING A NEW FORMULA: 
 
 

1. Click on the  button to display the Analysis menu.  
 
2. Click on the Formulae button to bring up the Formula Menu list box (See Fig.35). 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.35. The Formulae Menu Window 

 
 

3. Choose your frequency by clicking on the D, W, M, Q or Y buttons. The appropriate 
letter will be entered as the first character in the Formula Menu list box.  

 
4. Selecting a 7-day Average will result in formulae being calculated on a 7-day week basis 

not a 5-day week. If the formula is to be based on a 7-day week (a calendar series) 
then it may begin with C. e.g. CW, CM, CQ or CY.  

 
5. For ‘Straight’ series, an S is used instead of a C. e.g. SW, SM, SQ or SY. Straight 

Averages are calculating having first excluded data fields for which valid price data is 
unavailable.  

 
6. Click on the Load button to load a series into the formula. This will bring up the Load 

Series menu. (See Fig.17 Loading a Data Series). The new series will be displayed in the 
Formula Menu list box by its unique Platts identifier code. 
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7. Select an operator (add, subtract, multiply or divide) by clicking on the appropriate 

button or by typing it directly into the Formula Menu list box followed by a space.  
Continue to load series, enter numbers and operators until the formula is complete.   

 
8. Save the formula by clicking on the Save button and typing a name for the formula. 
 
9. Click on the OK button to display the Configure New Chart Line menu (See Fig.19), and 

follow the on screen instructions. 
 

 
 
 
6.4 LOADING A FORMULA: 
 
 

1. Previously saved formulae can be loaded into the Formula Menu list box. These saved 
formulae will be appended to any existing formulae in the window and will be enclosed 
in brackets. 
 

2. From the Formula Menu list box click on the Load button to display the Load Platts 
Sarus Formula window (See Fig.36).   
 

3. Select the required formula from the list of stored formulae and then click on the OK 
button to load the selected formula. 

 
 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.36. The Formula Loading Window  
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SECTION 7. EXPORTING DATA 

 
 
 
7.0 INTRODUCTION: 
 
The data in the current worksheet can be exported to a disk file for use in other applications. If 
no chart is open, the export button on the file menu will be 'greyed' out. 
 

 
 
7.1 EXPORTING CHART DATA: 
 
To export the data: 
 

1. Click on the  button to display the File Menu. 
 
2. Click on the Export Data button to display the Export Current Worksheet (See Fig.37). 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.37. The Export Worksheet Window 
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The data in the sheet can be exported in different formats. 
 
 

  EXCEL:  An Excel spreadsheet format file is written. The file extension 
XLS is automatically added. 

 
  LOTUS 123:  A Lotus 123 compatible WKS format file is written. The file 

extension WKS is automatically added. 
 
  ASCII:  A plain ASCII text file is written. The file extension .ASC is 

automatically added. 
 
  PRN:  A comma separated file format is written. The file extension .PRN is 

automatically added. 
 
 
 
 

3. Enter the directory path where the file is to be written. The path must end with a 
backslash key E.G.  C:\SARUS\ and enter a filename in the Name list box - It must be a 
valid DOS file name. 
 
 
4. There are two possible Fill options 
 

  Fill in All Missing Prices. This Option fills in any missing Prices by copying 
 forward the last previous valid price. 

 
 
  Pack Zero Values. Packing Zero Values is of use when exporting non-daily 

series and has the effect of stripping out extraneous zeros. 
 
 
5. Activate selection by clicking in the relevant checkbox. 
 
6. Click on one of the file type buttons (EXCEL, LOTUS 123, ASCII, PRN).  
 
7. Select the Date Range, specifying the desired Start and End dates. If no dates are specified, the 

entire series in the chart is automatically exported. 
 
8. Click on the OK button to save the file or on the Cancel button to abandon the file export. 
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SECTION 8. COMMUNICATIONS 
 

8.0 Introduction 
 
The Sarus FTP Dial-Up program allows Platts Sarus to retrieve its updated prices using the 
Internet.  In automatic mode, the Sarus FTP Dial-Up program will go to the Sarus FTP site each 
day and download any new program files and details of any new series added to database by 
Platts. Once this is complete, the program then goes to the Platts FTP site to retrieve the latest 
prices and corrections. The new Platts FTP service is year 2000 compliant. 
 
Once you complete your first download, each subsequent time the Sarus FTP program is run, it 
will check and notify you if any files have not been successfully downloaded thus helping to 
ensure your database is always up to date.  The Sarus FTP Dial-Up program allows you to 
retrieve any of the last 45 days of data from the Platts FTP site. 
 
To perform manual data downloads or to change the program settings you can manually run 
this program (See Fig.38.). 
 
Please note that because the Sarus FTP Dial-Up uses file recovery is a download is halted, if you 
perform a manual download for a date where some of the data files are still held locally then 
only missing or corrupt files will be downloaded. 
 
 
Platform: 
The minimum system requirements main are that this upgrade requires Windows 98, 2000, XP 
or NT. The machine that performs the download must have a local Internet connection and have 
sufficient resources to run windows correctly. 

 
 

8.1 Using the FTP Dialler 
 
 
1. The easiest way to run the new Sarus FTP Dial-Up program by clicking, with the right 

mouse button, on the Platts Scheduler running in the Windows task bar to activate it’s 
popup menu. Selecting the ‘Manual Download’ option from within the Platts Sarus 
application will also launch it. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig .38. The Sarus Scheduler Popup Menu. 

 
2. Using the Platts Scheduler, select the ‘Manual Download’ menu and the window (See 

Fig.39) will be displayed.  
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Fig .39. The Sarus FTP Download Program checking previous downloads. 

 
 

3. The Sarus FTP Dial-Up program checks and notifies you of any missing data thus 
allowing you to update only those missing dates. Once this is done the form below (See 
Fig.31 .) is displayed.  You will notice that there are two tabs, ‘Platts Download’ and ‘Sarus 
Download’ tabs. We use the ‘Platts Download‘ tab to perform daily the download and the 
‘Sarus Download’ tab to allow you to check for new series, program files and to request 
historical data for a date range. This section is covered later in this booklet after the 
‘Platts Download’ Tab. 

 
  

 
Fig .40. The Sarus FTP Download Program showing the P latts Download Tab. 

 
 
8.2 The Platts Tab. 
 
Use the spin control to select the download date. Once selected, click on the ‘Download’ button 
to begin. A typical download can take anywhere from 5 to 20 minutes depending on the amount 
of data you receive from Platts and the speed of your PC.  
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Once the download begins it occurs in the following 4 stages. 
 
1. Connecting to the Internet 
2. Connecting to the Sarus FTP site and checking for and downloading any new files. 
3. Connecting to the Platts FTP site and downloading any new data files for the required 

date. 
4. If the download is successful then all prices are validated and the database is updated 

using the existing Sarus Database update program. The Communications log file is 
updated. 

 
 
 
1. Connecting to the Internet (Dial-Up). 
 
The Sarus FTP Dial-Up program will use your existing Internet connection to dial up the 
Internet. 
 
 

 
 
 
 
 
 

 
Fig .41. The Sarus FTP Download Program connecting to the Internet. 

 
 
Normally you will see the same Dial-Up networking prompt that you see when connecting using 
your Web Browser (See Fig.41 .).  After dialling, you should see the messages ‘Dia lling’, ‘Verifying 
User Name and Password’ and ‘Connected’. Once the connection is successfully established the 
program will attempt to connect to the Sarus FTP site (See Stage 2). 
 
No te: If you are having problems connecting then check the Troubleshooting section at the 
end of this book. 

 
 
 

2. Connecting to the Sarus FTP site. 
 

Once a connection has been established, the FTP Dial-Up program will try (up to 4 times) to 
locate the Sarus FTP site ftp.sarus.com and check to see if any files need to be downloaded. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.42. The Sarus FTP Download  Program connecting to the Internet. 
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The files checked are: 
 
  A code conversion file (which tells Sarus how to convert the new 8 character Comstock 

codes to the old 9 character Dispatch codes). If the remote file is different then it is 
automatically downloaded and installed. 

 
  New Series added since the last download. Throughout the year Platts add new 

assessments. The Sarus FTP series database is kept up to date and holds descriptions 
and conversions for these series. New series details (excluding Futures) are downloaded 
and users are notified of them the next time Sarus is started or the following morning 
when the charts are refreshed.  

 
  New Program Files. In order to ensure that the Platts Sarus Software is kept up to date, 

new program files are automatically downloaded. These files will then be automatically 
installed the next time Sarus is started.  You will be notified before the installation 
occurs as to what changes have taken place in the software. 

 
Once this process is complete the program will attempt to connect to the Platts FTP site 
(See Stage 3). If any error occurs a message-box will be displayed identifying the 
problem.  

 
 

No te: You cancel the FTP download by clicking on the ‘Cancel’ button. You will be 
asked to confirm that you wish to cancel the download from the Sarus FTP site. You 
then have 10 seconds to cancel the download or it will automatica lly continue. If you 
cancel the download then the Platts FTP download will also be cancelled and the 
database will not be updated. If you are having problems connecting then check the 
Troubleshooting section at the end of this book. 

 
 
 

3. Connecting to the Platts FTP site. 
 

Once the Sarus FTP connection is completed, the Sarus FTP Dial-Up program will try (up to 
4 times) to connect to the Platts FTP site: ftp.platts.com. The program then logs you onto 
the site and checks the files on the Platts site with any held locally.  

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.43. The Platts FTP Download Program checking the files on the P latts FTP site. 

 
Only different files are downloaded. This means an interrupted download will start from exactly where it 
was halted makings downloads faster. If no new files are available, you will be notified and the program 
will exit. 
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The data files are received and stored on the local PC. Each file will be requested a number of 
times to ensure that all files are received correctly. If an error occurs a message will be 
displayed identifying the problem.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.44. The P latts FTP Download Program  retrieving files from the P latts FTP site. 
 
 

 
Once all the files are downloaded, the files are used to update the Platts Sarus Database after 
validation and the Sarus communications log is updated. 
 
Note:  If you are having problems connecting then check the Troubleshooting section at the 
end of this book. 

 
 
 
 
 

4. Validating and updating the Sarus Database. 
 
 

 
 

Fig.45 .  Processing the downloaded FTP files before updating the database. 

 
 
 
 

Once the data files are downloaded they are validated and written to an update file. The Platts 
Sarus Database Update Program then updates the price and corrections databases. 
 
 
Unknown codes normally refer to ‘intra-day’ prices and are ignored by Sarus. 
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Fig .46.  Updating the Sarus Database. 

 
 
This process takes a few minutes to complete then the corrections update program is 
automatically run. 
 
 
8.3 The Sarus Download Tab. 
 
The Sarus Download Tab allows you to request a manual download from the Sarus FTP site. 

 
Fig.47. The Sarus Download Tab. 
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There are three Download options available. You can select one or more of these options.  
 
 

1. Prices:  This option allows you to select a date range and request a historical download 
from the Sarus FTP server for all prices and corrections. You may type the Start and End 
dates  
directly or click on the small Date button to select a date. Please take care when 
requesting historical data for a large date range, as the compressed files to download 
can be very large.  You may wish to break the request into several requests (use smaller 
date ranges). 
If in doubt then please contact Sarus Systems on + 44 1842 829000 or e-mail 
support@sarus.comsupport@sarus.com 
 

2. New Codes: Throughout the year Platts add new assessments. The Sarus FTP series 
database is kept up to date and holds descriptions and conversions for these series. New 
series details (excluding Futures) are downloaded and users are notified of them the 
next time Sarus is started.  

 
3. Latest Files: In order to ensure that the Sarus Software is kept up to date, new program 

files are automatically downloaded from the Sarus FTP site. These files will then be 
automatically installed the next time Sarus is started.  You will be notified before the 
installation occurs as to what changes have taken place in the software. 

 
 

The Menus: 
 

There are three Drop-Down Menus above the ‘Platts Download’ and ‘Sarus Download’ tabs. 
 
 

 
 
 
 
 
 
 

Fig.48 . The Drop-Down Menus. 

 
 
 
 
 

8.4 The File Menu. 
 

From the File Menu you can select from two options, Utilities & Exit 
 

1. Utilities: - The Utilities Menu has three sub-menus 
 

 
a. Run Manual Update 

If for some reason the database did not update from the downloaded files, you can 
manually update the database by clicking on this menu to display the window 
below. 

 
 
 
 

 
 

 

Evaluation notes were added to the output document. To get rid of these notes, please order your copy of ePrint IV now.



Platts Sarus Workstation Manual 
 

 
  Page 44 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig .49.  Manually updating the database from saved data files from the P latts FTP site. 

 
 
 

Select the directory for the desired date. The directories are in the YearMonthDay format 
e.g. January 12 2002 would be displayed as 20020112. Click OK and the database will be 
updated (See Stage 4). 

 
 

 
b. Check Downloads 

Click on this menu and the Sarus FTP Dial-Up program will check and notifies you of 
any missing data files thus allowing you to update only those missing dates.  

 
 
 

 
 
 
 
 
 
 

 
Fig .50. The Sarus FTP Download Program checking previous downloads. 

 
 

 
c. Ping / Trace 

 
This option enables the user to Ping both the Sarus & Platts FTP sites and trace the 
Internet route taken. It is a useful diagnostics tool and can assist with connectivity 
problems. 
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Fig.51. The P ing / T race U tility 

 
 

1. Exit: -  Click on this menu to exit the Sarus FTP Dial-Up program. You have 10 seconds 
to decide or the program will automatically exit. 

  

 
 

Fig.52 . The Exit Program Dialog. 

 
8.5. The View Menu. 
 
From the ‘File’ menu you can select Settings, Current Session Log & The Sarus Communications 
Log.  

 

 
 

Fig.53. The V iew Menu. 
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 8.51. Settings. 
 

The Settings menu allows you to easily change default settings used in the program.  
There are five tabs pages ‘Platts’, ‘Sarus’ , ‘Local’, ‘Connection’ and ‘Mail’ We will 
look at the Platts and Sarus tabs first as they are both very similar. 
 
 
1. The Platts Tab. 
 
This is where we enter the settings, which enable us to access the Platts FTP site. (See 
Fig.56) 

 
  Check that your User ID as supplied to you by Platts is entered correctly. 
  No of File Retries should be set to two or three 
  Use of ‘Passive Connection’ is preferable as this has a significant speed benefit. 
  After Download Group-Box - This option allows you to select a program that will 

be run after a successful download. You may use this to update your own 
database or spreadsheet. 

 
 
 
 

 
 

Fig.54. The Platts Settings Tab. 
 

Note: The transfer mode for Platts FTP site is ASCII whereas for the Sarus FTP Site it is Binary.  
The Log-on to the Sarus FTP site is anonymous with a password of anonymous. 
The Platts FTP site requires a valid user name and password. This is supplied to you from 
Platts. 
If you have any problems then please contact Sarus Systems on + 44 1842 829000 or e-mail 
support@sarus.comsupport@sarus.com 
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2. The Sarus Tab.  
 

  The default settings shown above are suitable for most users. 
  The Sarus FTP Site has anonymous Login so the ‘Anonymous Log-in’ checkbox 

must be ticked. 
  Use of ‘Passive Connection’ is preferable as this has a significant speed benefit. 
  The Timeout settings can be adjusted if you are getting timeout errors from 

the Platts Dial-up program. The timeout settings should rarely be below 15 
seconds or greater than 60 seconds. 

  There are three checkboxes in the ‘Automatic Download’ section. These should 
be checked to enable automatic download of new Sarus upgrades. 
 
 
 

 
 

Fig.55. The Sarus Settings Tab. 
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3. The Local Tab. 
 

The Local Tab allows you choose the settings that are unique to your office and are 
displayed in three group-boxes. 

 

 
   

Fig.56. The Local Settings Tab. 

a. Local 
 
The path displayed shows the directory where the daily data and program files are 
stored. This path should not be changed unless instructed by a member of the Sarus 
support team.  If you feel that they are not correct then please contact Sarus Systems 
on + 44 1842 829000 or e-mail support@sarus.comsupport@sarus.com 
 
The Number of Days of historical data setting determines how many days worth of FTP 
files are stored on your PC before being deleted (the prices should already be in the 
database). This option should be set to 5 as a minimum as it will check and notify you if 
any files have not been successfully downloaded thus helping to ensure your database is 
always up to date.  

 
b. The Days to Auto Connect Group-Box 
 

These checkboxes identify which days of the week you want automatic 
downloads to take place (The Automatic Download times are controlled from the 
Sarus scheduler on the Windows Task Bar). Normally you can uncheck Sunday 
and Monday (in red) unless you are collecting assessments that update over the 
weekend, as a Saturday download will retrieve the Friday’s closing prices. 
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c. Automatic Download Times Group Box 
 

Click on the ‘Edit’ button, change the Automatic Download time and click on ‘Update’ to 
save your changes. You can also add other download times to cater for regional market 
closes during your working day.  
 
 

 
 

Fig.57. The Edit A utomatic Download times Group Box 

 
 
 
 
 
 
 
 
 

Evaluation notes were added to the output document. To get rid of these notes, please order your copy of ePrint IV now.



Platts Sarus Workstation Manual 
 

 
  Page 50 

 

  
 

4. The Connection Tab. 
 

The Connection Tab allows you choose the settings that are necessary to ensure proper 
FTP communications and are displayed in four group-boxes. 

 
 

 
 

Fig.58. The Connections Tab 
 

 
  Connection: - Select your Dial-up type, either ‘Direct Connection’ (Leased Line) or 

‘Dial Up Networking’ (ISDN or Modem). If you are using ‘Dial Up Networking’, select 
your ISP from the drop down list. 

 
  Proxy Server: - Enter your Proxy Server details in this section. These settings can 

also be found in Internet Explorer or Netscape. If you are unsure of these, contact 
your Systems Administrator or Sarus Systems for assistance.  

 
  Firewall: - Enter your Firewall details (if any) in this section. If you are unsure of 

these, contact your Systems Administrator or Sarus Systems for assistance. 
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  Proxy / Firewall Connection: - If you use a Proxy Server or Firewall, you will have to 

select the ‘Style’ from the options below. If you are unsure, contact your 
Systems Administrator or Sarus Systems for assistance. 

 
Note: Sarus provide a utility called FW Probe, which is located in the main Sarus 
directory. This Utility will assist in determining the correct ‘Style’. Please contact 
Sarus Systems on + 44 1842 829000 or e-mail support@sarus.comsupport@sarus.com for assistance 
running this utility. 

 

  
5. The Mail Tab. 

 
The Mail Tab allows you enter your settings that are necessary for requesting Historical data 
from Sarus Systems. (See section 7.3 The Sarus Download Tab). 
 

 

 
 

Fig.59. The Mail T ab 
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8.52. Current Session Log. 
 

The Current session log contains a detailed event log for all FTP activity performed by the Sarus 
FTP Dial-Up program. It is used primarily as an aid for diagnosing problems.  

 
 

 
Fig.60. The Current session log window. 

 
 
 

There are 3 buttons on the form: 
 

  Open Allows you to open an event log for a different date. 
 
  Save As  Allows you to save the event log as a text file so that it can be e-mailed 

to Sarus Systems in the event of an FTP problem.  
 
  Close. Closes this form. 
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8.53. The Sarus Communications Log. 
 
 

 
 

Fig.61 . The Sarus Communications Log window. 

 
 

The Sarus communications log shows the status after each download.  There should be a ‘Success’ 
entry for each date showing the number of files that were downloaded, the directory they were 
written to and the connection time. E.G.  
 
Success (Auto) 158/158 files were successfully downloaded to C:\Sarus\db\ftp\20020130\. Duration 
00:3:15 
 
This option is used primarily as a diagnostic aid.  
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8.6. The Help Menu 
 

  About 
 

 

 
 

Fig .56. The Sarus FTP D ial-Up Program A bout Box. 

 
 
 
The about menu displays the version and compile date of the Program. You can also send e-
mails to the support desks at both Platts and Sarus Systems. Simply click on either URL 
www.sarus.comwww.sarus.com or www.platts.comwww.platts.com. You can then compose and send your e-mail in the usual 
way. 
 
 

8.7 Troubleshooting. 
 
 

  A licensed version of Platts Sarus must be installed before you can use this program 
  You must use 32-bit Windows i.e. Windows 98, 2000, XP or NT 4.0. 
  The Platts scheduler must be running in the task bar for the automatic download to 

work. 
  This software must be installed using it’s own installation program 
 

 
 

Note: If you are having problems connecting then check the Dial-Up Networking settings using 
the ‘View/Settings’ menu. Select the Local tab and ensure the Internet connection name is 
correct and that the timeout is sufficient. If you are using a modem then allow a minimum of 90 
seconds. If you are not sure of how long it should take then dial-in using your browser and note 
how many seconds this takes. Add 30 to this number and set the timeout value to this. 
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If you are having a problem then try connecting to ftp.sarus.com using your existing 
web browser to ensure your Internet connection is working correctly and the hardware 
settings are correct. Please see the next section on fault reporting for more information. 
 
 
Fault Reporting: 
 
 
If you experience a problem with the Sarus FTP Dial-Up Program then please supply us with the 
following information and we will attempt to resolve it as speedily as possible. 
 

  Your full contact details including fax number and e-mail address. 
  As detailed a description of the fault as you can and include what actions trigger it. 
  Sample screen shots showing the problem 
  Details of when this problem first occurred. 
  A copy of the current session log  
  A copy of the Sarus.ini and SarusFTPDial.ini files located in the windows directory. 

 
Note: In you are sending screen shots as BMP or Clipboard images files then please compress 
them so that they are transmitted quickly.  JPG format is more efficient. 
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SECTION 9. THE SARUS SPREADSHEET 
 
9.0. Overview. 

 
The Platts Sarus spreadsheet allows you to easily load multiple series directly into a Microsoft 
Excel ‘97 (workbook) spreadsheet.  These spreadsheets can then be refreshed and new prices 
automatically added each day. 
 
These series can be selected for a given date range and loaded by frequency (Daily to Yearly) 
and unit of measurement ($/BBL, $/MT or C/Gall).  
 
You must have Platts Sarus installed on your PC for this program to work and run Microsoft 
Excel 97 or later. 

 
 

9.1. Creating a new Sarus Spreadsheet Workbook. 
 
Once you have installed the Platts Sarus spreadsheet you can load data by opening a Sarus 
spreadsheet template. To do this, click on the ‘File/New’ menu.  Double-click on the Sarus 
Spreadsheet template (See Fig.63.). If it is not immediately visible then look under the 
‘Spreadsheet Solutions’ tab as it may be installed there. Click on the ‘OK’ button to proceed. 

 
 

 
Fig .63. Creating a new Platts Sarus Spreadsheet 
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A Platts Sarus workbook will be created and a new ‘Platts Database’ menu will added to the 
Excel menu bar (See Fig.64).  
 
 

 
 
 
 
 

 
Fig .64. The Platts Database menu. 

 
 
9.2. The Platts Database Menu. 

 

To view the options available, simply click on the  new ‘Platts Database’ menu to display the 
dropdown menu below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig .65. The opened Platts Database m enu. 

 
 
 
The ten menu options are: 
 
 

a. Load Platts Data: 
 

This option allows you to select and load historical data series from the Sarus database into a sheet 
in the current Excel workbook.  

 
 

b. Create Correlation: 
 

This option allows you to create a correlation between two series. 
 
 

c. Create Mean of Means: 
 
This option displays the mean of the mean of two series. 
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d. Edit current sheet: 
 

This option allows you to make changes and edit the open sheet. 
 
 

e. Load a Template:  
 
Templates are selections of data series that have been saved in a file with a descriptive 
title. Templates make it easy and fast to create new spreadsheets using frequently used 
series. 
 
 

f. Save Worksheet as Template:   
 

This option allows you to save the series in the active spreadsheet to the template file 
making it available to be loaded later. Note: Only the series from the current 
spreadsheet are saved as a template not the whole workbook. 
 
 

g. Delete a Template:    
 

This option allows you to delete a saved template from the group file. 
 

 
h. Refresh open Platts Sheets: 
 

This option reloads and refreshes the data series in all open Sarus spreadsheets.  
 
 

i. Settings:   
 
Contains user defined customisable settings including number of decimal places, date 
format and timed sheet refresh. The timed sheet refresh function executes the ‘Refresh 
open Platts Sheets’ function (above). This user-defined time is usually set so that all the 
sheets are updated before the user begins work. 
 

 
j. About Sarus Spreadsheet: 

 
This option shows the ‘About’ box displays the Sarus Spreadsheet version number.  
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9.3. Loading Data into the Workbook. 
 
To load some data series into an Excel spreadsheet (in the current workbook), simple click on 
the new ‘Platts Database’ menu (See Fig.65) to display the dropdown menu and select the 
‘Load Platts Data’ option to display the window below (See Fig .66). 

 
 

 
 

Fig.66 . The ‘Load Data Series’ fo rm. 
 
The Load Data series form has a number of controls designed to make it easy to find and load the series 
you require. These series can be displayed in any frequency, average and unit of measurement for any 
given date range. These features and controls are described below. 
 
 

1. Available Platts Data Series. 
 
This multi-select list box contains the descriptions and codes of all the series currently active on your PC. 
You can select series by clicking on them in conjunction with the ‘Control’ and ‘Shift‘ keys. Please see the 
details on the ‘Filter’ button for assistance on locating series. 

 
Frequency: 
 
This option allows you to have Sarus calculate some time averages for the selected series 
 
The frequency options are: 
 
Daily, Weekly, Half Monthly, Monthly, 3 Monthly, 6 monthly and Yearly. 
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Average: 
 
Use the ‘Average’ drop down menu to select if (non-daily frequency) series are calculated as: 
 

  5-Day Filled:  A filled forward weekday average where, if a holiday occurs, the previous valid 
price is used and the week’s prices are then divided by 5. 

 
  7-Day Filled:  A filled forward 7-day average where the Friday’s price is used for the Saturday 

and Sundays and then the week’s prices are divided by 7. 
 
  Straight:  A 5-day average where holidays and missing prices are ignored (for example, if 

Monday were a holiday then you would get a 4 day average for that week).   
 
Unit: 
 
For applicable series, Sarus holds conversion factors that allow the series to be converted to 
Dollars/Barrel, Dollars per Metric Tonne and cents per Gallon, as they are loaded. The option 
‘None’ loads the series ‘as reported’ with no ‘Unit’ conversion. 
 
Mean: 
 
If the series has both a high and low price then you can select either one and if the mean 
checkbox is checked, Sarus automatically loads both series and displays the mean price. 
 
Filled: 
 
This option will fill missing prices with the previous value. 
 
 
Start Date: 
 
This option allows you to select the earliest date to load from the selected series. Click on the 
button and select a (weekday) date using the window below (See Fig .68).  
 
 
Days: 
 
This option allows you to select a user defined rolling number of days. (See Fig.67).  
 
 
 

 
 

Fig.67 
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Fig.68. Selecting a Date Range fo r the series. 

 
 

 

End Date: 
 
This option allows you to select the last date to load from the selected series. (See Fig.68).  
 
 
 
Filter: 
 
The filter window (See Fig.69.) allows you to view and select series that contain certain 
words. 

 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.69. The Filter window 

 

 
 

Type in the filter words and only series containing these words will be displayed together with 
your currently selected series. To clear a filter click on the ‘Clear’ followed by the ‘OK’ button.  
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Fig .70. The Load Data Series w indow with selected series and a filter containing the word ‘Brent’ applied.  
 
 

In the example (See Fig.70), we have some selected ‘BRENT’ series and we applied a filter 
using the word ‘WTI’. As you can see the selected series are still selected and by holding 
down the CONTROL key and clicking on names, new series can be added to the selected 
list. 
 
 
2. Displaying the selected series: 
 
Once you have completed your selection, click on the ‘OK’ button to display the data.  You 
will be asked if you wish to create a new sheet. If you say yes then you will be given the 
opportunity to change the display order of the series and a new sheet will be added to 
your workbook otherwise the current sheet will be used and a ll data deleted. 
 
In the example shown (See Fig.71), we have displayed 6 series as Monthly Straight 
averages beginning in 1999. 
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Fig.71 . Microso ft Excel 97 disp laying 4 series.  
 
 
You can now use the spreadsheet as you would any other spreadsheet with one added 
advantage, you can reload all the data by clicking on the ‘Platts Database’ menu then selecting 
the ‘Refresh open Platts Sheets’ option.  
 
 

9.4. Templates. 
 
Templates are files that contain logical groups of series that you wish to store so that you can 
reuse then easily in new spreadsheets. For example, you may have a set of  “European 
Products” and  “Asian Products” that you use frequently. Saving these series as a template 
means that these series can be reloaded instantly without searching and filtering names. A 
template also holds Units of measurement, Average and frequency details together with the 
saved date range for the series.  
 
 

9.41. Loading a Template: 
 
To load a template, click on the ‘Platts Database’ menu followed by the ‘Load a 
Template’ menu. If a template has been saved then the window below  (See Fig.72) will 
be displayed. 
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Fig.72. Selecting a template to Load. 

 
Select the template you require and click on the ‘Load’ button. The template will be loaded 
into the ‘Load Data Series’ window (See ‘Loading Data into the Workbook’ section earlier). 

 

 
 

Fig.73 . The saved template settings 

 

Evaluation notes were added to the output document. To get rid of these notes, please order your copy of ePrint IV now.



Platts Sarus Workstation Manual 
 

 
 Page 65 
 

 

You can now edit the settings then click on the ‘OK’ button to load the template into the 
workbook.  

 
 
 

9.42. Save Worksheet as Template: 
 
To save a template, click on the ‘Platts Database’ menu followed by the ‘Save Worksheet as 
Template’ menu. When a template is saved it will be available when you next select the ‘Load a 
Group’ option. (See Fig .72) 
 
 
9.43. Delete a Template: 
 
To delete a template, click on the ‘Platts Database’ menu followed by the ‘Delete a Group’ 
menu. When a Group is deleted it is no longer available. 

 
 
 
 

If you have any questions, please contact:  
 
Sarus Systems   Tel: ++ 44 1842 829000.   
 
Email:    sarus@sarus.comsarus@sarus.com 
    support@sarus.comsupport@sarus.com 
 
 
Your local Platts office. 
 
Or visit our web site at  http:// www.sarus.comhttp:// www.sarus.comwww.sarus.com  
 
 
 
Both this software and the data are protected by international copyright 
and cannot be used without the express written permission from its 
owners. 
  
 
Remember, on-line help is available from within Sarus program with the F1 
function key and from HELP on the top Menu bar. 
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